
3.0 ENTERING SERT DATA  
 
When a CDDP receives a report of an incident involving one or more serious 
events, the CDDP enters information about the incident into the web-based 
SERT database maintained by SPD.  This section of the manual is about how to 
enter information into that database.  
 
Tips:   
 
� When the manual is viewed as a Portable Document File (“pdf”), click on a 
figure hyperlink to view SERT screens as they are referenced. Click on 
“Previous View” arrow to return to manual after viewing a figure. 
 
� Log in to the test site  (user ID: snewton; password: test123) to view options 
in the fields, see how to move through initial entry and updates, and produce 
some reports before making entries that affect the CDDP database. 
 
� The SERT system “times out” after 20 minutes of inactivity. This is very likely 
to occur during long narrative entries, for example, since SERT recognizes 
activity only as screen changes through links or “submit” buttons.    Time out is 
indicated by the appearance of the SERT Login screen when a hyperlink or 
“submit” button is selected.  Options for recovering from time-out: 

1. Click the “back” button of web browser to return to last screen where data 
is stored.  All data should still be available. 

2. Select File>New>Window or Control+N.  This opens a new browser 
window with the same content as the original window. 

3. Click the “forward” button of web browser.  Type in user name and 
password and click on login page.  This returns user’s SERT Home Page 
and resets the 20-minute time clock on the login.  User should be able to 
submit the information already entered into the form without retyping it. 

4. Press ALT and Tab keys at the same time to return to the original browser 
screen with form and entered information.  Click “submit” button for that 
particular form. 

5. User may return to SERT Home Page by pressing the ALT and Tab keys 
at the same time again.  (This additional window can be closed at any 
time without impacting work.  Closing the window to save computer 
memory space is recommended if computer system is slow.) 
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Avoid time-outs by typing long narrative sections (e.g. description of incident, 
recommendations, investigation outcomes) in a word processing program like 
Word or Word Perfect before logging in to the system.  Copy the text in the 
document by highlighting it and pressing the Ctrl and C keys at the same time or 
by selecting Edit>Copy from the toolbar.  Click in desired SERT field and press 
Ctrl and V keys at the same time or select Edit>Paste from the toolbar to paste 
the document into the SERT web form. 
 
�  DO NOT WRITE A SERIOUS EVENT REPORT OVER A PREVIOUSLY-
ENTERED REPORT.  A unique ID# and entry date attaches to each SERT 
report as it is created.  The new event will retain the previous entry’s ID# and 
date, creating errors in entry, review and investigation timelines.  Contact the 
SERT Technical Coordinator---using the unique SERT ID#---to request that 
duplicate or otherwise invalid reports be eliminated from the CDDP database. 

 

3.1 Accessing SERT Database 
 
The SERT database is secure.  Each user must obtain a unique identification 
and password from the SPD Technical Coordinator (see Appendix A for form 
and contact information).  Access is designed according to user need, e.g. 
CDDP-specific access to input and edit data for users responsible for data entry 
and review or read-only access for users responsible for administration of the 
system.   
 
To access the SERT login site: 

1. Launch web browser (e.g., Internet Explorer, Firefox, etc.); 
2. Enter SERT address in browser address field: 

https://oddsweb.mhd.hr.state.or.us/counties/qa/login/login.cfm; and 
3. Click browser’s “Go” button. 

 

3.2 Logging in to SERT Database 
 
Enter user ID and password where indicated on the SERT database Login 
Screen (see Figure 3.1).  Click “Login” button to be directed to the SERT Home 
Page for the user’s CDDP.  
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3.3 Navigating to SERT Reporting Form  
 
On the SERT Home Page (See Figure 3.2, the options for hypothetical “Steve” 
County), include Add an Event, Submit County Monthly SERT Review, Change 
or View Profile, Online Reports, List of Events, View Licensing Citations, State 
SERT Team Minutes, and Logout of SERT System.  Click on “Add an Event”  
for the SERT Reporting Form (Figure 3.3) and enter SERT data. 

 

3.4 Entering Data in SERT Reporting Form
 
The SERT Reporting Form has two major sections:  CLIENT INFORMATION 
and INCIDENT INFORMATION.  Each section contains several fields for user 
entry. For example, “Case Number*” is the first field in the CLIENT 
INFORMATION section of the form.  Fields marked with asterisks (e.g., Case 
Number*, DOB*, Last Name*, etc.) are required fields that must be completed 
for SERT to accept the report. 
 
Table 3.1 provides information for completing each field of the SERT Reporting 
Form.  

Table 3.1 SERT Reporting Form 

Field Instructions 

Case 
Number 

Enter CPMS number of Individual---the person with developmental 
disabilities who is the focus of incident report. Until otherwise 
instructed, use the Individual’s CPMS number. 

DOB Enter Individual’s date of birth exactly as it appears in the CPMS 
record. Enter date in following format: MM/DD/YYYY. 

Last Name Enter last name of Individual exactly as it appears in the CPMS 
record. 

First Name Enter first name of Individual exactly as it appears in the CPMS 
record. 

Client is 
Under 18 

Check box if Individual was 17 or younger when incident occurred. 
(Facilitates review of events involving children over time.) 

Gender Enter capital M if Individual is male and capital F if Individual is 
female. 

Incident 
Date 

Enter date incident occurred in the following format: MM/DD/YYYY. 
If specific date of is unknown, enter approximate or estimated date, 
and check Approximate Incident Date box. If incident spans 
several days, enter date it began.   
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Field Instructions 

Date Incident 
Reported to 

County 
Enter date incident was reported to CDDP. Enter date in following 
format: MM/DD/YYYY. 

Approximate 
Incident 

Date 

Check box if specific date of incident is unknown and date in 
“Incident Date” field is approximate. 

Provider (at 
the time of 
incident) 

Indicate provider immediately responsible for supporting Individual 
when incident occurred.  Navigate through drop-down menu by 
entering first letter of provider name, then scrolling to appropriate 
selection, for example: 
1. Name of residential service agency if Individual is enrolled in 

24-hour residential or support living services, unless incident 
occurs when Individual is receiving services from an 
employment/alternative service provider. Also use this option if 
event occurs while Individual is temporarily away from the 
setting on vacation or visiting family.   

2. Name of employment/alternative to employment service 
agency if event occurs when Individual is receiving services 
from that agency, including when service is a self-directed 
purchase (through support services or comprehensive in-home 
support) or is provided as a nursing facility specialized service.  

3. Foster care when Individual receives foster care services, 
unless incident occurs when Individual is receiving services from 
an employment/alternative service provider. Also use this option 
if event occurs while Individual is temporarily away from the 
setting on vacation or visiting family.   

4. Independent provider when Individual is receiving a family 
support, comprehensive in-home support, CIIS or adult support 
service at the time of the incident from an independent 
contractor, an employee of the individual, or a self-employed 
worker.  

5. Nursing facility if reporting death of Individual who resides in a 
nursing facility unless the death occurs while Individual is 
receiving DD nursing facility specialized services. 

6. Transportation if incident involves public transportation 
employee, Individual is not enrolled in a comprehensive 
residential service, and no other paid DD service provider          
is directly responsible for the Individual at the time of the 
incident. 
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Field Instructions 

7. Unknown when: a) name of agency or other provider is 
unknown; b) no provider is responsible for or providing services 
at the time of the incident; or c) name of provider does not 
appear on the dropdown menu. 

Payment 
Source (if 

Self-
Directed 
Service) 

Select payment source if Individual receives self-directed services, 
even if none are being provided at the time of incident, i.e.:  
1. Brokerage when Individual is an adult enrolled in a Support 

Service Brokerage;  
2. Children’s Intensive In-Home when Individual is a child and 

receives SPD Children’s Intensive In-Home Support program 
services;  

3. Comp In-Home when Individual is an adult and receives 
Comprehensive In-Home Support services through the CDDP; 
or 

4. Family Support when Individual is a child and receives Family 
Support services through the CDDP. 

Site 

Choose specific provider site responsible for Individual when 
incident occurred.  This may not always be where the incident 
occurred, e.g. select name of home if incident occurred in park 
while Individual was out with residential staff and select name of 
employment program if incident occurred in park while Individual 
was landscaping with program crew.   All currently licensed or 
certified DD sites are in the dropdown menu for this field.  Search 
for the agency name, then select the appropriate site.  Exceptions: 
1. Select Family or own home if incident occurs in the home of a 

child or adult who either receives some type of self-directed 
service or receives only CDDP service coordination unless the 
incident occurs during provision of in-home services by a DD 
licensed or certified agency. 

2. Select Site not listed from the menu if the responsible site is 
unknown or not on the menu AND enter the site name in the 
associated field titled If site is not available on the dropdown 
list enter it below.  

Service 
person was 

receiving 
when event 

occurred 

Select type of service Individual was receiving when incident 
occurred from dropdown menu. For example, select: 
1. Comp InHome if Individual was receiving supports from a 

provider paid with Comprehensive In-Home Support funds. 
2. Case Management if Individual was directly receiving 

assistance from a Service Coordinator. 
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Field Instructions 

3. Brokerage if Individual was directly receiving assistance from 
Adult Support Service Brokerage staff or volunteers. 

4. Support Svcs (svcsPurchasedByBrokerage) if Individual was 
receiving supports from a provider paid with Support Service 
Brokerage funds. 

5. 24hr Residential if Individual resides in a 24-hour residential 
setting and was on an unescorted excursion in the community. 

6. Unknown if type of service is unknown or Individual was not 
directly receiving any of the services listed when the incident 
occurred.   

NOTE:  Do not select High School Transition---it is no longer 
available as a DD service. 

Address of 
Incident 

Enter street address where incident occurred. If specific street 
address is unknown, enter identifying information such as “West 
Hills Shopping Mall,” or “On Yamhill Road between 3rd and 5th St. in 
Portland.”  Do not enter something general like “Community” if even 
approximate location is unknown; leave this field blank and check 
the Unknown box.  

City Enter name of city where incident occurred. 

Unknown Check box if identifying information about the location of the 
incident is unavailable. (See Address of Incident field.) 

 
 
 
 

Field:  Type 
of Incident 

The following fields name or describe Serious Events.  Mark the box next to 
each serious event that occurs in the context of the incident being reported. 
Remember: a single incident may involve more than one Serious Event.  See 
Table 2.1.3 for a summary of SERT reporting based on living or service 
settings and age of individual. 

Death 

Check box to report an Individual---child or adult---has died 
under any circumstances.   If, after initial review and 
consultation with SPD and OIT, it appears death was caused 
by other than accidental or natural means or occurred in 
unusual circumstances, this may be abuse according to 
Statute and Rule (see Table 2.1.1A) and a Protective Service 
Investigation is required. 
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Field:  Type 
of Incident 

The following fields name or describe Serious Events.  Mark the box next to 
each serious event that occurs in the context of the incident being reported. 
Remember: a single incident may involve more than one Serious Event.  See 
Table 2.1.3 for a summary of SERT reporting based on living or service 
settings and age of individual. 

A PSI is required in the following cases unless initial review and 
consultation with OIT indicates that circumstances do not meet 
definitions of abuse in Statute or Rule 

Physical 
injury by other 
than accident 

(Physical 
Abuse) 

Check box if it appears the Individual---child or adult---in any 
setting has experienced abuse defined by Statute and Rule 
(see Table 2.1.1A).  An example that has been used in OIT 
Mandatory Abuse Reporting training is the presence of bruises 
indicating perpetrator is involved. 

Willful 
infliction of 

physical pain 
(Injury/pain) 

Check box if it appears Individual---child or adult---in any 
setting has experienced abuse defined by Statute and Rule 
(see Table 2.1.1A).  Examples that have been used in OIT 
Mandatory Abuse Reporting training: medication 
mismanagement resulting in injury; physical fights involving an 
adult; some domestic violence situations. 

Sexual 
harassment 

or exploitation 

Check box if it appears Individual---child or adult---in any 
setting has experienced abuse defined by Statute and Rule 
(see Table 2.1.1A).  Examples that have been used in OIT 
Mandatory Abuse Reporting training: any sexual contact 
between an employee, provider, or other caregiver and an 
adult; unwelcome sexual contact directed toward the adult by 
anyone else; consensual or nonconsensual with staff; rape or 
sexual assault. 

Failure to 
act/neglect 

Check box in these situations: 
1. It appears Individual---child or adult---in any setting has 

experienced abuse defined by Statute and Rule (see Table 
2.1.1A) or 

2. It appears that the Individual---child or adult—has 
experienced abuse as indicated in Table 2.1.1B by staff or 
volunteers in settings listed in that Table.  

An example that has been used in OIT Mandatory Abuse 
Reporting training is withholding food and hydration. 

Verbal 
mistreatment 

Check box if it appears Individual---child or adult---has 
experienced abuse as indicated in Table 2.1.1B by staff or 
volunteers in settings listed in that Table.   

Placing 
restrictions on 

Check box if it appears Individual---child or adult---has 
experienced abuse as indicated in Table 2.1.1B by staff or 
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Field:  Type 
of Incident 

The following fields name or describe Serious Events.  Mark the box next to 
each serious event that occurs in the context of the incident being reported. 
Remember: a single incident may involve more than one Serious Event.  See 
Table 2.1.3 for a summary of SERT reporting based on living or service 
settings and age of individual. 

an individual’s 
freedom of 
movement 

volunteers in settings listed in that Table.  Examples of such 
restriction include blocking a doorway, or shutting off an 
electric wheelchair. 

Using restraints 
inappropriately 

Check box if it appears Individual---child or adult---has 
experienced abuse as indicated in Table 2.1.1B by staff or 
volunteers in settings listed in that Table.   

Financial 
exploitation 

Check box if it appears Individual---child or adult---has 
experienced abuse as indicated in Table 2.1.1B by staff or 
volunteers in settings listed in that Table.   

Inappropriately 
expending an 
individual’s 

personal funds 

Check box if it appears Individual---child or adult---has 
experienced abuse as indicated in Table 2.1.1B by staff or 
volunteers in settings listed in that Table.   

 
PSI is NOT required for the following serious events in the absence 
of any apparent abuse.  These events are entered into SERT only if 
Individual---child or adult---receives services listed in Table 2.1.2. 

 

Fire 
department 

(service) 

Check box if circumstances appear to be those associated 
with Fire department in Table 2.1.2. 

Police 
(service) 

Check box if circumstances appear to be those associated 
with Police in Table 2.1.2.   

Criminal 
referral made 

Check box if circumstances appear to be those associated 
with Criminal referral made in Table 2.1.2. 

Ambulance 
service other than 
routine transport 

Check box if circumstances appear to be those associated 
with Ambulance service other than routine transport in 
Table 2.1.2. 

Medical 
hospitalization 

Check box if circumstances appear to be those associated 
with Medical hospitalization in Table 2.1.2.    

Emergency 
room visit 

Check box if circumstances appear to be those associated 
with Emergency room visit in Table 2.1.2.     

Psychiatric 
hospitalization 

Check box if circumstances appear to be those associated 
with Psychiatric hospitalization in Table 2.1.2. 
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The final fields of the SERT Reporting Form are: 
 

Field Instructions  

Description of 
incident 

 

Enter complete description of the incident:   
� What happened to Individual?  Describe what occurred, 

reported cause, any observations leading to suspicion of 
abuse, any immediate steps taken to protect Individual. 

� Who was involved? Note others involved and 
relationship to Individual if known. 

� When and where did it occur (if not clear from entries in 
report form fields)? 

Case Manager 
ID 

Optional to assist with local follow-up:  Enter name or other 
identifier of Individual’s Service Coordinator. 

 
After completing the SERT Reporting Form, click “Submit Client Information & 
Continue” for the Decision screen (see Figure 3.3 in Section 3.5).  An “Errors 
in Form” screen will pop up if “Submit Client Information & Continue” was 
selected before all required fields were completed. Return to the SERT 
Reporting Form, fill in all required information, and re-submit the information. 

 

3.5 Making Decision about Investigation 
The Decision screen documents the CDDP’s initial decision about whether an 
incident requires a protective service investigation.  This initial decision is based 
on the type of event reported as well as cursory evaluation of circumstances 
using current instruction and advice from OIT.   If necessary due to findings of 
subsequent review or investigation, the CDDP can update SERT to change this 
decision (see Section 4). 
 
3.5.1  Protective Service Investigation NOT Required   
There are three situations where a decision that a PSI is not required during 
initial entry of a serious event may be appropriate.   
 

1. The incident is a report only of death---with no other alleged abuse or 
neglect---of an individual receiving any DD services, including service 
coordination (case management).  This serves to immediately report the 
death and establish a “placeholder” for the case in SERT pending SPD 
Medical Director review.  The CDDP must inform the SPD Medical 
Director of the death immediately, leaving the county review open and 
available for update to protective services investigation if necessary.     
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2. The incident appears only to involve one or more of the events in Table 

2.1.2---other than death---that are not considered types of abuse in any 
setting.   

 
3. Clarifying basic elements of the event and consulting protective service or 

OIT personnel indicates alleged action does not meet conditions for or 
definitions of abuse listed in Tables 2.1.1A or 2.1.1B in Section 2.  

 
Click the “No, County will Review” button to be directed to County Review of 
Serious Event form (see Section 3.6). 
 
3.5.2 Protective Service Investigation Is Required 
If there is any indication that the incident may involve one or more of the types 
of abuse other than death (see Section 3.5.1) in Tables 2.1.1A or 2.1.1B in 
Section 2---according to age or services received—a decision to proceed with a 
protective services investigation is required on initial entry of the serious event.   
 
Special Considerations:  
 

1. If an incident involves death and another serious event from Tables 
2.1.1A or 2.1.1B, make the decision that protective services investigation 
is required.  Consult with OIT and immediately notify the SPD Medical 
Director of the death. 

 
2. CDDPs often receive reports that must also be referred to other agencies 

for investigation or other resolution.   DHS Child Welfare investigates child 
abuse or may delegate investigation to OIT. If a crime is involved, so is 
law enforcement.  OIT investigates allegations of abuse involving 
individuals in State Operated Community Program services.  Investigation 
information, process and timelines in all of these cases are not under a 
CDDP’s immediate control and any further activity that might be required 
of the CDDP usually depends on unique factors associated with each 
case.  Nevertheless, using SERT to indicate a protective service 
investigation is required, as well as to record referral to the appropriate 
agency, what the CDDP knows or learns about the case (including reports 
and outcomes shared by the investigating agency), and CDDP activities 
(e.g. action to protect Individual, collaboration with investigating agency, 
monitoring investigation progress, subsequent or separate investigation, 
follow-up on recommendations or required actions) prior to closure.   
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Click the “Yes, Submit Complaint/PSI Request” button to be directed to Initial 
Complaint Form (see Section 3.7).  
 

3.6 Entering Data in County Review of Serious Event 
Form  
 
CDDP service coordinators, QA staff or management, separately or as a team, 
clarify the nature of these serious events and take any steps necessary to 
address causes and prevent recurrence.  It is not necessary to complete the 
entire form on initial entry; update as the review process develops and 
concludes.  The form must, however, be completed—as indicated by the date 
entered in the Date Review Completed field---within 45 days of entering the 
serious event in SERT. 
 
Table 3.2 provides instructions for entering data about this CDDP review 
process in each field of the County Review of Serious Event form (Figure 3.5).  
Field instructions also apply to Update County Review of Serious Event form 
(Figure 4.6) 
 
 
 

Table 3.2 County Review of Serious Event form  
Field Instructions 

 
County to review 

 
IMPORTANT---CLICK ON THIS BOX 

Although the NO box has been selected on the previous 
Decision screen, data cannot be accurately sorted and 
analyzed if this field is not completed.   

Explanation of 
why does not rise 

to PSI level 
 

1. If incident involves death and no other related alleged 
abuse, note that CDDP has taken this step as 
temporary measure pending SPD Medical Director 
advice about possibility of abuse OR enter that SPD 
Medical Director has determined investigation is 
required. 

2. If incident report alleged any other type of abuse 
according to Tables 2.1.1A and 2.1.1B, enter 
explanation why incident does not require 
investigation, including input from OIT. 

3. If only serious events from Table 2.1.2 are involved, 
field may be left blank.   
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Field Instructions 

Recommendations 
Made 

Record recommendations CDDP review generated for 
provider, Service Coordinator, or other parties.  Include 
information about how recommendations were presented 
to provider, date, response, etc.  Leave field blank if 
CDDP review indicates issue resolved, no further action 
required.    

Follow Up 
Required 

Check box if CDDP plans follow-up with provider, Service 
Coordinator, or other party to see if appropriate action is 
taken on recommendations.    

Date Follow Up 
Completed 

If Follow Up Required box is checked, enter date CDDP 
completes follow-up.  Enter date in the following format: 
MM/DD/YYYY.  

Date Review 
Completed 

Enter date CDDP considers adequate steps have been 
taken to address concerns associated with the incident 
and review is complete.  If review indicates follow-up is 
required to resolve concerns, wait to complete this field 
until after the follow-up is complete.   Enter the date in the 
following format: MM/DD/YYYY. 

 
Click “Submit Form Now” button after entering data.   On “The serious event has 
been entered” screen (Figure 3.6), select: 

1. “Add another event” to return to the SERT Reporting Form (Figure 3.3) or 
2. “Return to SERT Home Page” for your CDDP (Figure 3.2) and either 

logout of the SERT System or select another option (e.g., Download 
SERT Data, etc.). 

 

3.7 Entering Data in Initial Complaint Form 
 
The Initial Complaint Form  (Figure 3.7) is an extended report about serious 
events that involve abuse.   These reports are not automatically sent to the 
Office of Investigations and Training, the agency that tracks abuse and 
protective service activity in developmental disability services.  To ensure OIT is 
aware of new or changing status of PSIs, CDDPs must:
� Notify OIT when a serious event originally designated for County Review 

is changed to PSI; and  
� Obtain OIT’s agreement to change a serious event from PSI status to 

County Review status. 
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 Table 3.3 provides instructions for entering data in the (PSI) Initial Complaint 
Form (Figure 3.7).  The field instructions also apply to the Complaint & 
Investigation Update Form (Figure 4.7) discussed in section 4.0 of the manual. 

 
Table 3.3 Initial Complaint Form 

Field Instructions 
County PSI Unit for 

investigation 
Check box if incident is referred to CDDP 
Protective Service Investigation (PSI) Unit.  

Phone If incident is referred to CDDP PSI Unit, enter 
telephone number of PSI Unit or Investigator. 

District Attorney Check box if incident is referred to local District 
Attorney’s office for investigation. 

Phone If incident is referred to local DA’s office, enter 
telephone number of contact. 

Seniors and People 
with Disabilities 

Check box if incident has been referred to SPD 
Medical Director. 

Office of 
Investigations and 

Training 

Check box if incident is referred to OIT for 
investigation. Checking box does NOT mean OIT 
receives automatic notice through SERT of 
CDDP’s referral.  Refer directly to OIT.    

Police 

Check box if incident is referred to law 
enforcement for investigation.  Checking box does 
not mean automatic referral through SERT or that 
case is accepted/investigated.  Refer directly.  
Follow up and update SERT regularly.  

Phone If incident is referred to law enforcement, enter 
telephone number of contact. 

Child Welfare Check box if incident is referred to DHS Child 
Welfare.  

Date Referred If the incident is referred to DHS Child Welfare, 
enter date of referral in format: MM/DD/YYYY. 

Other Write in name of any other agency to which 
incident is referred 

Phone If incident is referred to some other agency for 
investigation, enter agency telephone number 

Person Reporting 
Enter name of person reporting incident (reporter) 
to CDDP.   Leave field blank if reporter declines to 
provide name. 

Person Wishes to 
Remain Anonymous 

Check Yes box if: 1) Reporter wishes to remain 
anonymous; or 2) Reporter is willing to give name 
to the CDDP, but not for CDDP to give name to 
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Field Instructions 
anyone else---enter reporter’s name in “Person 
Reporting” field, and check the “Yes” box. 

Telephone Enter telephone number—if available---of reporter. 

Relationship to 
Alleged Victim 

Enter nature of relationship between reporter and 
Individual (e.g., friend, sister, residential service 
provider, etc.). 

Address (of victim) Enter home address of Individual 

Telephone (of victim) Enter telephone number (with area code) of 
Individual. 

Does alleged victim 
have a guardian? Check Yes box if Individual has a guardian. 

Has guardian been 
notified? 

Check Yes box if Individual has guardian and 
guardian has been notified of the incident.  

Staff Taking Report Enter name of CDDP employee to whom incident 
was reported.  

Time of Call 

Enter time of day incident was reported to CDDP. 
Enter hour and minutes and “am” or “pm.” Do not 
use periods when inputting “am” and “pm” (i.e., do 
not input a.m. or p.m.) 

Last Name (of alleged 
perpetrator) 

Enter last name of alleged perpetrator (person 
alleged to have committed abuse) of the incident.  
(Space is available to enter information for up to 
four alleged perpetrators.) 

First (name of alleged 
perpetrator) Enter first name of alleged perpetrator of incident. 

Address (of alleged 
perpetrator) Enter address of alleged perpetrator of incident. 

Phone (of alleged 
perpetrator) 

Enter telephone number of alleged perpetrator of 
incident. 

 
After entering data, click button labeled “Submit” to reach the Complaint & 
Investigation Decision form/screen (Figure 3.8). 
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3.8 What To Do When the Investigation Has—or Has 
Not—Been Completed 

 
The Complaint & Investigation Decision form/screen asks, “Has the 
investigation been completed?”  Click on one of four answers: 

 
1. Yes Complete Investigation form 
2. No 
3. Add another event 
4. Return to SERT Home Page 

 
Select answers 2, 3, or 4 if the investigation has not been completed, e.g. the 
Initial Complaint Form for the serious event is complete, but the investigation 
is ongoing or the report is not finalized. 

3.8.1 Selecting Answer 2 
Click on answer 2, “No,” to indicate investigation in not complete and return to 
the SERT Home Page for your CDDP (Figure 3.2). 

3.8.2 Selecting Answer 3 
Click on answer 3, “Add another event,” to indicate investigation is not 
complete, and you want to enter data for one or more other incidents in the 
database. You will be returned to the SERT Reporting Form (Figure 3.3). 

3.8.3 Selecting Answer 4 
Click on answer 4, “Return to SERT Home Page,” to indicate investigation is not 
complete and return to the SERT Home Page for your County (Figure 3.2). 

3.8.4 Selecting Answer 1 
Click answer 1, “Yes Complete Investigation form,” to indicate investigation has 
been completed and go to the Investigation Information form (Figure 3.9).   

Please note:  This instruction assumes user completes the Initial Complaint 
Form and the Investigation Information form at the same time.  However, these 
forms are typically completed at different points in time. In fact, the Investigation 
Information form is only available during the initial incident entry session.  
Another form, the Complaint & Investigation Update Form (Figure 4.7) will 
appear for subsequent updates.   Refer to Section 4.0 “Finding and Updating 
Incident Data” to learn how to find and update the data for a previously entered 
incident.    
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3.9 Entering Data in Investigation Information Form 
 
The Investigation Information form must be completed---as indicated by date 
entered in the “Date Investigation Completed” field---within 45 days of entry of 
the serious event.   
 
Table 3.4 provides instructions for entering data into the fields of the 
Investigation Information form (Figure 3.9).  Instructions also apply to the 
Complaint & Investigation Update Form (Figure 4.7) discussed in section 4.0 
of this manual. 
 

Table 3.4 Investigation Information form 
Field Instructions 

Investigation 
Outcome 

Click appropriate “radio button” if: 
1. Incident involves single allegation and alleged perpetrator 

OR 
2. Incident involves multiple allegations or multiple 

perpetrators, but all outcomes are the same. 
Do not click a button if: 
1. Incident involves multiple allegations, perpetrators and 

outcomes.  Detail outcomes per allegation in Investigation 
Summary or Summary and Conclusions for In-Home 
Investigations fields.  

2. Investigation closed without outcome.  Explain why, 
including OIT input, in Investigation Summary or 
Summary and Conclusions for In-Home Investigations 
fields, as appropriate. 

Investigation 
Summary 

 

Use this field unless circumstances meet conditions for 
optional online reporting under Summary and Conclusions 
for In-Home Investigations (see below).   
Enter: 
1. Brief summary of investigation outcomes per allegation, 

recommendations, response to recommendations, 
protective services provided or offered, other agency 
referrals/actions AND note full report on file with OIT; OR 

2. The investigation report completed by the CDDP, consistent 
in content and format with current OIT instruction 

Action as a 
Result of 

Investigation 

Use this field unless circumstances meet conditions for 
optional online reporting under Summary and Conclusions 
for In-Home Investigations (see below).   
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Field Instructions 
List actions CDDP---and, if known and applicable, the 
Individual’s support service brokerage---has taken or will take 
as a result of the investigation, including related timelines.   

Summary and 
Conclusions 
for In-Home 

Investigations 
 
 

This field is an option for submitting physical abuse or neglect 
investigation reports to OIT through SERT, but only when 
Individual lives at home (own or family) and receives only 
service coordination, adult support (brokerage) services 
or comprehensive in-home services.  If this field is used, 
additional information will not be required in the Investigation 
Summary or Action as a Result of Investigation fields on 
the Investigation Information screen.   
 
Provide information and format according to current OIT 
guidance, e.g. allegation(s), statute and rule violated, 
protective services action taken, other agency referrals and 
actions, summary and conclusions, outcome, 
recommendations and timelines for response. 

Investigator’s 
Initials Enter initials of Investigator completing investigation. 

Date 
Investigation 
Completed 

Enter date investigation and investigation report are complete. 
Enter date in format: MM/DD/YYYY. 

Enter County 
PSI Event 
Code… 

CDDP option:  Enter any code used internally to track serious 
events.   

Follow Up 
Required 

Check box if CDDP must perform follow-up activity after close 
of investigation.  

Date Follow-
Up 

Completed 

If follow-up field is checked, enter date CDDP completes 
follow-up. Enter date in format: MM/DD/YYYY. 

 
After entering data, click “Submit Investigation Information” button to reach a 
screen indicating changes have been entered into SERT (Figure 3.10). This 
screen also allows return to SERT Home Page. 
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Figure 3.1 
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Figure 3.2 
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Figure 3.3 
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Figure 3.4 
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Figure 3.5 
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Figure 3.6 
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Figure 3.7 
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Figure 3.8 



Figure 3.9 
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Figure 3.10  
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